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SAR TEST REPORT 
STYLISTIC T series tablet PC  

Model: T732 / TH702  
Report Number: M120829_FCC_MC8355_SAR_GSM-UMTS 

 
2.0 INTRODUCTION 

 
Testing was performed on the Fujitsu TABLET PC, Model: T732 / TH702  with SIERRA Mini-PCI Wireless WAN 
Module (GOBI 3000), Model: MC8355, with INTEL Mini-PCI Wireless LAN Module (INTEL CENTRINO 
ADVANCED-N 6205 (TAYLOR PEAK) 802.11a/b/g/n), Model: 62205ANHMW & TAIYO YUDEN Bluetooth 
Module, Model: BCM92070MD_REF6. Bluetooth Transmitter nominal power is less than 5mW.  The GOBI 3000 
module is an OEM product.  The Mini-PCI Wireless WAN (WWAN) was tested in the dedicated host – 
STYLISTIC T SERIES , Model T732 / TH702 . The system tested will be referred to as the DUT throughout this 
report. 

 
 
 
3.0 TEST SAMPLE TECHNICAL INFORMATION 

 (Information supplied by the client) 
 
3.1 WWAN Details 
Table 2 

Transmitter: WWAN (UMTS/EVDO combo)  
FCC ID: N7NMC8355 
IC: 2417C-MC8355 
Model Number: MC8355 
Manufacturer: SIERRA WIRELESS INC 
Network Standard: GSM Release 6 /  
UMTS bands :  IMT 2100 / 850 / 1900MHz(Band Class I, II, V) 
GSM / EDGE bands:  850 / 900/ 1800 / 1900 MHz 
Channel spacing:  200KHz(GSM), 5MHz(WCDMA) 
Channel raster:  200kHz  
Antenna type:  Main: Monopole, AUX: PIFA 
Antenna 
Manufacturer:  

NISSEI ELECTRIC CO. LTD.  

Antenna Part Number:  Main: CP519214, AUX: CP519215 
 



 WWAN - FCC ID: N7NMC8355 IC: 2417C-MC8355     Report No. M120829_FCC_MC8355_SAR_GSM-UMTS            Page 5 of 190 
  

 

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 
 
 

3.2 Test Signal, Frequency and Output Power 
 
The DUT was provided by Fujitsu Australia Pty Ltd.   It was put into operation using a Rhodes & Schwarz Radio 
Communication Tester CMU200.  The channels utilised in the measurements were the traffic channels shown 
in the table below.  The power level was set to Class 4 for 850 MHz and Class 1 for 1900 MHz GSM bands and 
class 3 for 850 , 1700 and 1900 MHz UMTS bands. 
 

Channels and Output power: 

Table 3 

Channel and Mode 
 

Frequency  
MHz 

Average 
Output Power 

dBm 
GPRS Mode   

Channels 128, 190 and 251 824.2, 836.6 and 848.8 33 
Channels 512, 661 and 810 1850.2, 1880 and1909.8  30 

UMTS Mode   
Channels 4132, 4183 and 4233 826.4, 836.6 and 846.6 24 
Channels 9262, 9400 and 9538 1852.4, 1880 and 1907.6 24 
Channels 1312, 1427 and 1513 1712.4, 1735.4 and 1752.6 24 

CDMA Mode   
Channels 1013, 384 and 777 824.7, 836.52 and 848.31 23 
Channels 25, 600 and 1175 1851.25, 1880 and 1908.75 23 
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3.3 DUT (Notebook PC) Details 
 
The intention of this application is to certify Sierra Wireless Inc. WWAN module FCC ID: N7NMC8355 and IC: 
2417C-MC8355 in a Fujitsu host PC model T732/TH702 with WLAN model Intel 62205ANHMW AND Bluetooth 
model BCM92070MD_REF6  (FCC ID: EJE-WL0029 and IC: 337J-WL0029) 
 
SAR testing was conducted on the sample that is equipped with the Bluetooth transmitter with antenna and 
Intel WLAN modules with antenna. 
 
According to the manufacturer specifications the Bluetooth is a low power transmitter (4dBm), also Bluetooth 
Antenna is located >5cms from any other antenna in the system. The Antenna location is shown on page 32 of 
this report. 

Table 4 

Host notebook : STYLISTIC T series  
Model Name: T732  / TH702 
Serial Number: Pre-production Sample 
Manufacturer: FUJITSU LIMITED 
  
CPU Type and Speed: Core i7 2.9GHz   
LCD 12.5”WXGA(1280x800 : LP125WH2 
Graphics chip None 
Wired LAN: Intel  82579LM : 10 Base-T/100 Base-TX/1000Base-T 
Modem: None 
Port Replicator Model: FPCPR132 
  
AC Adapter Model: 80W: ADP-80RB A(Delta),  SEE100P2-19.0(Sanken), 

PJW1942N(Tamura), PJW1942NA(Tamura) 
100W: A11-100-3A (Chicony) 

Voltage: 19 V 
Current Specs: 4.22A / 5.26A 
Watts: 80W / 100W 

 
 

*The model numbers shown T732 and TH702 are for the same product. The difference between T732 
and TH702 is color and target market. 
The T732 is for commercial market. 
The TH702 is for consumer market. 
 
 

Test sample Accessories 
 
3.3.1 Battery Types 
One type of Fujitsu Lithium Ion battery is used to power the DUT. 
 
Standard Battery      

Table 5 

Model Li-ion   
V/mAh 10.8V/6700mAh   
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4.0 TEST SIGNAL, FREQUENCY AND OUTPUT POWER 
 
For the SAR measurements the DUT was operating at full transmit power. The fixed frequency channels used 
in the testing are shown in Tables below. 
 
The frequency span of the GSM, UMTS  and CDMA bands was more than 10MHz consequently; the SAR 
levels of the test sample were measured for lowest, centre and highest channels in the applicable modes. 
There were no wires or other connections to the STYLISTIC T series tablet PC during the SAR measurements.  
At the beginning of the SAR tests, the conducted power of the GOBI 3000 model MC8355 was measured after 
temporary modification of antenna connector inside the Host’s  TX RX compartment. Measurements were 
performed with a calibrated Power Meter. The results of this measurement are listed in tables below. Burst 
Average power was used to calculate the Frame Average power (100% Duty Cycle) which determines the 
worst case Multislot Class.  
 
Conducted Power Measurement CDMA 2000 1xRTT 850/1900 MHz 
 
Configuration: 
Network > System Parameters > System ID = 2004; Network Identity > Network ID Number = 65535 
 
Service cfg > Primary Service Class > Selected Service = Loopback Service; Primary Service Class > 
Loopback Service > Selected Service Option = Service Option x (x -  2, 9 or 55); Service Option x (x -  2, 9 or 
55) > FCH Config > Frames > Frame Rate = Full; Selected Service Option > Service Option 55 > FCH Config > 
FCH > F-FCH-MO = 0001hex (Fundamental Channel Test Mode 1) or 0002hex (Fundamental Channel Test Mode 2) 
 
Service cfg > Primary Service Class > Selected Service = Test Data Service; Primary Service Class > Test 
Data Service > Selected Service Option = Service Option 32; Test Data Service Option 32 > FCCH & SCH 
Config > SCH0 Enable = Off (or On); Test Data Service Option 32 > FCCH & SCH Config > SCH1 Enable = Off 
(or On); Test Data Service Option 32 > FCCH & SCH Config > SCH0 Config  >  Data Rate = 9.6 kbps; FCCH & 
SCH Config > SCH1 Config  >  Data Rate = 9.6 kbps 
 
BS Signal > RF Settings > RF Power > CDMA Power = -104 dBm/1.23MHz (RF > External attenuation IN/OUT 
as per cable losses); RF Settings > RF Channel [BC0] = 384; RF Settings > RF Channel [BC1] = 325; BS 
Signal > RF Settings > RF Power > PICH Level = -7dB; BS Signal > FCH > FCH Level = -7.4 dB 
BS Signal > Power Control > Power Ctrl. Bits = All Up (Service Options 2,9 and 55)  
BS Signal > Power Control > Power Ctrl. Bits = Hold (Service Options 32) 
 

Table 6 

Cellular Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 

1 N/A SO 2 N/A N/A 25.10 25.13 24.88 
1 N/A SO 55 N/A N/A 25.09 25.09 24.89 
2 N/A SO 9 N/A N/A 25.11 25.08 24.90 
2 N/A SO 55 N/A N/A 25.08 25.07 24.87 

N/A 3 N/A SO 32 OFF 25.04 25.08 24.89 
N/A 3 N/A SO 32 ON 25.09* 25.06* 24.88* 

*SCH1 Enable – rejected by DUT 
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PCS Band 
Fundamental 
Channel Test 

Mode 

Supplemental 
Code 

Channel Test 
Mode 

Loopback 
Service 
Option 

Test Data 
Service 
Option 

SCHn Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 

1 N/A SO 2 N/A N/A 23.49 22.83 23.09 
1 N/A SO 55 N/A N/A 23.62 22.93 23.12 
2 N/A SO 9 N/A N/A 23.60 22.95 23.15 
2 N/A SO 55 N/A N/A 23.56 23.06 23.16 

N/A 3 N/A SO 32 OFF 23.70 22.94 22.98 
N/A 3 N/A SO 32 ON 23.60 22.95 22.99 

 
Conducted Power Measurement 1xEvDo Revision 0 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release 0; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -105.5 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); 
RF Settings > RF Channel [BC0] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control 
bits = All Up 
Layer > Application Layer > Test Applications > FTAP Cfg > DRC > ACK Ch Fixed Mode = Ack.Always; 
DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > RTAP Cfg > Data > Min. Rate = 5 (153.6 
kbps); Data > Min. Rate = 5 (153.6 kbps) 
 

Table 7 

Cellular Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 
0 -81 dB 25.16 25.26 24.97 

 

Table 8 

PCS Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 
0 -84 dB 23.84 23.19 23.31 
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Conducted Power Measurement 1xEvDo Revision A 850/1900 MHz 
 
Configuration: 
Network > Network Release = Release A; Network > System ID = 2004; Access Probes > Initial Adjust (Probe 
Initial Adjust) = 15 dBm; Probe Increment (Power Step) = 7.5 dB/step; Open Loop Adjust (BC0) =  -81 dB (US 
cellular); Open Loop Adjust (BC1) = -84 dB (N.American PCS) 
AN Signal > Sector > Format = Manual; Sector ID = 00800580 00000000 00000000 00000000; RF Settings > 
RF Power > 1xEv-Do Power = -60 dBm/1.23MHz (RF > External attenuation IN/OUT as per cable losses); RF 
Settings > RF Channel [BC0] = 37; RF Settings > RF Channel [BC1] = 325; Power Control > Power control bits 
= All Up 
Subtype 0: 
Layer > Protocol View Filter = Release 0 Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Fixed Rate = 4 (307.2 kbps, 2-slots); Test Applications > 
RTAP Cfg > Data > Min. Rate = 5 (153.6 kbps); Data > Max. Rate = 5 (153.6 kbps) 
Subtype 2: 
Layer > Protocol View Filter = Release A Settings; Layer > Application Layer > Test Applications > FTAP Cfg > 
DRC > ACK Ch Fixed Mode = Ack.Always; DRC > Rate = 16 (307.2 kbps, 2-slots); Test Applications > RTAP 
Cfg > Data > Min. Packet Size = 9 (4096 bits); Data > Max. Packet Size = 9 (4096 bits); 
 
 

Table 9 

Cellular Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 1013 Ch. 384 Ch.777 
0 -81 dB N/A* N/A* N/A*
2 -81 dB 25.12 25.17 24.90 

 

Table 10 

PCS Band 
Release 0 Subtype Open Loop Adjust (BC0) Result (dBm) 

Ch. 25 Ch. 600 Ch.1175 
0 -84 dB N/A* N/A* N/A*
2 -84 dB 23.66 23.12 23.27 

*DUT has no Subtype 0 capabilities 
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Table: Frequency and Conducted Power Results GSM 

Table 11 

Coding Scheme GPRS Multislot 
Class 

RF Channel Measured Power 
Burst Average 

(dBm) 

Calculated Power
Frame Average 

(100% Duty Cycle) 
(dBm) 

CS1 10 128 33.21 27.03 
CS1 10 190 33.27 27.09 
CS1 10 251 33.23 27.05 
CS1 11 128 N/A* N/A*
CS1 11 190 N/A* N/A*
CS1 11 251 N/A* N/A*
CS1 12 128 N/A* N/A*
CS1 12 190 N/A* N/A*
CS1 12 251 N/A* N/A*

Table 12 

Coding Scheme EGPRS Multislot 
Class 

RF Channel Measured Power 
Burst Average 

(dBm) 

Calculated Power
Frame Average 

(100% Duty Cycle) 
(dBm) 

MCS5 10 128 32.85 26.67 
MCS5 10 190 33.02 26.84 
MCS5 10 251 32.82 26.64 
MCS5 11 128 N/A* N/A*
MCS5 11 190 N/A* N/A*
MCS5 11 251 N/A* N/A*
MCS5 12 128 N/A* N/A*
MCS5 12 190 N/A* N/A*
MCS5 12 251 N/A* N/A*

*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities 

Table 13 

Coding Scheme GPRS Multislot 
Class 

RF Channel Measured Power 
Burst Average 

(dBm) 

Calculated Power
Frame Average 

(100% Duty Cycle) 
(dBm) 

CS1 10 512 28.55 22.37 
CS1 10 661 28.41 22.23 
CS1 10 810 28.30 22.12 
CS1 11 512 N/A* N/A*
CS1 11 661 N/A* N/A*
CS1 11 810 N/A* N/A*
CS1 12 512 N/A* N/A*
CS1 12 661 N/A* N/A*
CS1 12 810 N/A* N/A*
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Table 14 

Coding Scheme EGPRS Multislot 
Class 

RF Channel Measured Power 
Burst Average 

(dBm) 

Calculated Power
Frame Average 

(100% Duty Cycle) 
(dBm) 

MCS5 10 512 27.89 21.71 
MCS5 10 661 27.99 21.81 
MCS5 10 810 27.75 21.57 
MCS5 11 512 N/A* N/A*
MCS5 11 661 N/A* N/A*
MCS5 11 810 N/A* N/A*
MCS5 12 512 N/A* N/A*
MCS5 12 661 N/A* N/A*
MCS5 12 810 N/A* N/A*

*DUT has no GPRS/EGPRS Multislot Class 11 and 12 capabilities 
 

Conducted Power Measurement UMTS 850 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 15 
Channel No. βc βd Result (dBm) 

4132 8 15 25.05 
4183 8 15 25.15 
4233 8 15 25.08 

 
Conducted Power Measurement UMTS + HSDPA 850 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
  

Table 16 
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR

(dB) 4132 4183 4233 
1 2 15 8 8 8 24.49 24.62 24.62 0.0 
2 12 15 8 8 8 24.34 24.42 24.41 0.0 
3 15 8 8 8 8 24.18 24.22 24.23 0.5 
4 15 4 8 8 8 24.08 24.16 24.17 0.5 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 850 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 
 

Table 17 

 
 
Conducted Power Measurement UMTS 1700 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 18 
Channel No. βc βd Result (dBm) 

1312 8 15 22.96 
1427 8 15 23.14 
1513 8 15 23.16 

 
Conducted Power Measurement UMTS + HSDPA 1700 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  

Table 19 
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR

(dB) 1312 1427 1513 
1 2 15 8 8 8 22.45 22.68 22.72 0.0 
2 12 15 8 8 8 22.07 22.33 22.38 0.0 
3 15 8 8 8 8 21.99 22.17 22.28 0.5 
4 15 4 8 8 8 21.97 22.16 22.23 0.5 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆ 
E-DPCCH 

βed
(SF) 

βed
(codes

) 

AG
Index 

Result (dBm) MPR
(dB) 4132 4183 4233 

1 10 15 8 8 8 6 4 1 20 24.45 24.51 23.93 0.0 
2 6 15 8 8 8 8 4 1 12 22.81 22.82 22.61 2.0 
3 15 9 8 8 8 8 4 2 15 23.64 23.41 23.25 1.0 
4 2 15 8 8 8 5 4 1 17 22.95 22.58 23.05 2.0 
5 15 15 8 8 8 7 4 1 21 23.85 23.86 23.80 0.0 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1700 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 

Table 20 

 
Conducted Power Measurement UMTS 1900 MHz 
 
Configuration: 
12.2 kbps RMC 
Test Loop Mode 1 
βc = 8, βd = 15 (3GPP default) 
TPC (Transmit Power Control) = All 1s 

Table 21 
Channel No. βc βd Result (dBm) 

9262 8 15 23.62 
9400 8 15 23.64 
9538 8 15 23.76 

 
Conducted Power Measurement UMTS + HSDPA 1900 MHz 
 
Configuration: 
Device HSDPA Category 6 (Downlink 3.6 Mbps and Uplink 384 kbps) 
H-Set  = 1 
QPSK in H-Set (1) 
CQI Fidback Cycle = 4ms; CQI Repetition Rate = 2ms 
 3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  

Table 22 
Sub Test No. βc βd ∆AKN ∆NAKN ∆CQI Result (dBm) MPR

(dB) 9262 9400 9538 
1 2 15 8 8 8 23.14 23.20 23.29 0.0 
2 12 15 8 8 8 22.95 22.92 23.05 0.0 
3 15 8 8 8 8 22.78 22.72 22.83 0.5 
4 15 4 8 8 8 22.79 22.75 22.77 0.5 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆  
E-DPCCH 

βed 
(SF) 

βed 
(codes) 

AG 
Index 

Result (dBm) MPR 
(dB) 1312 1427 1513 

1 10 15 8 8 8 6 4 1 20 21.92 22.01 22.05 0.0 
2 6 15 8 8 8 8 4 1 12 20.26 20.28 20.41 2.0 
3 15 9 8 8 8 8 4 2 15 21.27 21.13 21.26 1.0 
4 2 15 8 8 8 5 4 1 17 20.02 20.07 20.16 2.0 
5 15 15 8 8 8 7 4 1 21 21.88 21.89 22.01 0.0 
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Conducted Power Measurement UMTS + HSDPA + HSUPA 1900 MHz 
 
Configuration: 
Device HSUPA Release 6 (5.7 Mbps) 
RMC 12.2 kbps + HSPA 34.108 with loop mode 1 
HS-DPCCH, E-DPCCH, E-DPDCH  Enabled 
DPCH Channel Code {βd (SF)} = 64 
Power Control – TPC algorithm 2 
3GPP default HS-DPCCH power offset parameters ∆AKN = 5; ∆NAKN = 5;  ∆CQI = 2  
E-TFCI table index = 0 
E-DCH minimum set E-TFCI = 9 
PLnon-max = 0.84 
Maximum Channelisation Code {βed (SF) and βed (codes)} – Subtests 1,2,4,5 = SF4; Subtest 3 = 2xSF4 
Initial Serving Grant Value = Off 
∆ HARQ =0 
Number of Ref.E-TFCIs – Subtests 1,2,4,5 = 5; Subtest 3 = 2 
Set1 Patern Type = Closed Loop 

Table 23 

 
 

 

Sub 
Test 

βc βd ∆ 
AKN 

∆ 
NAKN 

∆ 
CQI 

∆ 
E-DPCCH 

βed
(SF) 

βed
(codes

) 

AG
Index 

Result (dBm) MPR
(dB) 9262 9400 9538 

1 10 15 8 8 8 6 4 1 20 22.57 22.71 22.77 0.0 
2 6 15 8 8 8 8 4 1 12 20.91 20.96 20.88 2.0 
3 15 9 8 8 8 8 4 2 15 21.89 22.03 21.67 1.0 
4 2 15 8 8 8 5 4 1 17 21.28 21.37 21.05 2.0 
5 15 15 8 8 8 7 4 1 21 22.55 22.67 22.75 0.0 
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4.1 Battery Status 
The DUT battery was fully charged prior to commencement of measurement.  Each SAR test was completed 
within 30 minutes.  The battery condition was monitored by measuring the RF field at a defined position inside 
the phantom before the commencement of each test and again after the completion of the test. It was not 
possible to perform conducted power measurements at the output of the DUT, at the beginning and end of 
each scan due to lack of a suitable antenna port. The uncertainty associated with the power drift was less than 
5% and was assessed in the uncertainty budget. 
 
5.0 DETAILS OF TEST LABORATORY 
 
5.1 Location 
EMC Technologies Pty Ltd  
176 Harrick Road 
Keilor Park, (Melbourne) Victoria 
Australia 3042 
  
Telephone: +61 3 9365 1000 
Facsimile: +61 3 9331 7455 
email:  melb@emctech.com.au 
website: www.emctech.com.au 
 
5.2 Accreditations 
EMC Technologies Pty. Ltd. is accredited by the National Association of Testing Authorities, Australia (NATA).  
NATA Accredited Laboratory Number: 5292 
 
EMC Technologies Pty Ltd is NATA accredited for the following standards: 

Table 24 

AS/NZS 2772.2: RF and microwave radiation hazard measurement 
ACMA: Radio communications (Electromagnetic Radiation - Human Exposure) Standard 2003 
FCC: Guidelines for Human Exposure to RF Electromagnetic Field OET65C 01/01 
EN 50360: 2001 Product standard to demonstrate the compliance of mobile phones with the basic 

restrictions related to human exposure to electromagnetic fields (300 MHz – 3 GHz) 
EN 62209-1: 2006 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 

communication devices - Human models instrumentation and procedures. 
Part 1: Procedure to determine the specific absorption rate (SAR) for hand-held devices 
used in close proximity to the ear (300 MHz to 3 GHz)

EN 62209-2:2010 Human Exposure to radio frequency fields from hand-held and body-mounted wireless 
communication devices - Human models instrumentation and procedures 
Part 2: Procedure to determine the specific absorption rate (SAR) for wireless 
communication devices used in close proximity to the human body (frequency range of 30 
MHz to 6 GHz 

IEEE 1528: 2003 Recommended Practice for Determining the Peak Spatial-Average Specific Absorption 
Rate (SAR) in the Human Head Due to Wireless Communications Devices: Measurement 
Techniques. 

Refer to NATA website www.nata.asn.au for the full scope of accreditation. 
 
5.3 Environmental Factors 
The measurements were performed in a shielded room with no background RF signals. The temperature in the 
laboratory was controlled to within 21±1°C, the humidity was in the range 36 % to 39 %. The liquid parameters 
are measured daily prior to the commencement of each test.  Tests were performed to check that reflections 
within the environment did not influence the SAR measurements. The noise floor of the DASY5 SAR 
measurement system using the SN1380 probe was less than 5μV in both air and liquid mediums. 
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6.0 DESCRIPTION OF SAR MEASUREMENT SYSTEM 
Table 25 

Applicable Head Configurations : None 
Applicable Body Configurations : Lap Held Position 

: Edge On Position 
: Bystander 

 
6.1 Probe Positioning System 
The measurements were performed with the state-of-the-art automated near-field scanning system DASY5 
Version 52 from Schmid & Partner Engineering AG (SPEAG). The DASY5 fully complies with the OET65 C 
(01-01), IEEE 1528 and EN62209-1 and EN62209-2 SAR measurement requirements.  
 
6.2 E-Field Probe Type and Performance 
The SAR measurements were conducted with SPEAG dosimetric probe ET3DV6 Serial: 1380. Please refer to 
appendix C for detailed information. 
 
6.3 Validation 
 
6.3.1 Validation Results (900 MHz and 1800 MHz and 1950 MHz) 
 
The following tables lists the dielectric properties of the tissue simulating liquid measured prior to SAR 
validation. The results of the validation are listed in columns 4 and 5. The forward power into the reference 
dipole for SAR validation was adjusted to 250 mW. 
 
Table: Validation Results 

Table 26 

1. Validation 
Date & 

Frequency 
2. ∈r 

(measured) 
3. σ (mho/m) 
(measured) 

4. Measured 
SAR 1g (mW/g) 

5. Measured 
SAR 10g (mW/g) 

1950 MHz  
20th August 2012 51.9 1.59 9.66 5.00 

1800 MHz 
21st August 2012 51.2 1.54 9.28 4.98 

1950 MHz 
22nd August 2012  51.8 1.59 9.91 5.14 

900 MHz 
23rd August 2012 53.0 1.05 2.81 1.83 

 
6.3.2 Deviation from reference validation values 
The reference SAR values are derived using a reference dipole and flat section of the SAM phantom suitable 
for a centre frequency of 900 and 1800 MHz and 1950 MHz. These reference SAR values are obtained from 
the IEEE Std 1528-2003 and EN 62209-2 and are normalized to 1W.  
 
The SPEAG calibration reference SAR value is the SAR validation result obtained in a specific dielectric liquid 
using the validation dipole during calibration. The measured one-gram SAR should be within 10% of the 
expected target reference values shown in table below. 
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Table: Deviation from reference validation values @ (900MHz and 1800 MHz and 1950 MHz) 

Table 27 

 
Frequency and 
Date  

Measured 
SAR 1g 
(mW/g)  

Measured 
SAR 1g 
(Normalized 
to 1W) 

SPEAG 
Calibration 
reference SAR 
Value 1g 
(mW/g) 

Deviation From SPEAG 
Reference 1g (%) 

1950 MHz  
20th August 2012 9.66 38.64 38.8 -0.41 

1800 MHz 
21st August 2012 9.28 37.12 38.7 -4.08 

1950 MHz 
22nd August 2012  9.91 39.64 38.8 2.16 

900 MHz 
23rd August 2012 2.81 11.24 11.1 1.26 

 
NOTE: All reference validation values are referenced to 1W input power. 
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6.3.3 Liquid Depth 15cm 
 

During the SAR measurement process the liquid level was maintained to a level of 15cm with a 
tolerance of 0.5cm.  
 

 
Photo of liquid Depth in Flat Phantom 

 
 
6.4 Phantom Properties 
The phantoms used during the testing comply with the OET65 C (01-01), IEEE 1528 and EN62209-1 and 
EN62209-2 SAR measurement requirements.  
 
Phantom Properties Required Measured  
Thickness of flat section 2.0mm ± 0.2mm (bottom section) 2.12-2.20mm 
Dielectric Constant <5.0 4.603 @ 300MHz (worst-case frequency) 
Loss Tangent <0.05 0.0379 @ 2500MHz (worst-case frequency) 
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6.5 Tissue Material Properties 
The dielectric parameters of the human tissue simulating liquid were measured prior to SAR assessment using 
the HP85070A dielectric probe kit and HP8753ES Network Analyser.  The actual dielectric parameters are 
shown in the following table. 
 

 
 

 
Table: Measured Body Simulating Liquid Dielectric Values at 850MHz 

Table 28 

Frequency 
Band 

∈r 
(measured 

range) 
∈r 

(target) 
σ (mho/m) 
(measured 

range) 
σ 

(target) 
ρ 

kg/m3 

824.2 MHz 
Body 53.7 55.2 ±5% 

(52.4 to 58.0) 0.97 0.97 ±5% 
(0.92 to 1.02) 1000 

836.6 MHz 
Body 53.6 55.2 ±5% 

(52.4 to 58.0) 0.98 0.97 ±5% 
(0.92 to 1.02) 1000 

848.6 MHz 
Body 53.5 55.2 ±5% 

(52.4 to 58.0) 0.99 0.97 ±5% 
(0.92 to 1.02) 1000 

Note:  The body liquid parameters were within the required tolerances of ±5%.   
 

 
 

Table: Measured Body Simulating Liquid Dielectric Values at 1700MHz 

Table 29 

Frequency 
Band 

∈r 
(measured 

range) 
∈r 

(target) 
σ (mho/m) 
(measured 

range) 
σ 

(target) 
ρ 

kg/m3 

1712.4 MHz 
Body 51.5 53.3 ±5% 

(50.6 to 56.0) 1.48 1.49 ±5% 
(1.42 to 1.56) 1000 

1735.4 MHz 
Body 51.5 53.3 ±5% 

(50.6 to 56.0) 1.50 1.49 ±5% 
(1.42 to 1.56) 1000 

1752.6 MHz 
Body 51.4 53.3 ±5% 

(50.6 to 56.0) 1.51 1.49 ±5% 
(1.42 to 1.56) 1000 

  Note:  The body liquid parameters were within the required tolerances of ±5%.   
 
 

Table: Measured Body Simulating Liquid Dielectric Values at 1880MHz 

Table 30 

Frequency 
Band 

∈r 
(measured 

range) 
∈r 

(target) 
σ (mho/m) 
(measured 

range) 
σ 

(target) 
ρ 

kg/m3 

1850 MHz 
Body 52.2 53.3 ±5% 

(50.6 to 56.0) 1.53 1.52 ±5% 
(1.44 to 1.60) 1000 

1880.0 MHz 
Body 52.1 53.3 ±5% 

(50.6 to 56.0) 1.55 1.52 ±5% 
(1.44 to 1.60) 1000 

1910 MHz 
Body 52.0 53.3 ±5% 

(50.6 to 56.0) 1.57 1.52 ±5% 
(1.44 to 1.60) 1000 

Note:  The body liquid parameters were within the required tolerances of ±5%.   
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6.5.1 Liquid Temperature and Humidity 
The humidity and dielectric/ambient temperatures were recorded during the assessment of the tissue material 
dielectric parameters. The difference between the ambient temperature of the liquid during the dielectric 
measurement and the temperature during tests was less than |2|°C. 
 
Table: Temperature and Humidity recorded for each day 

Table 31 

Date Ambient 
Temperature (°C) 

Liquid 
Temperature (°C) 

Humidity (%) 

20th August 2012 20.5 20.2 39 
21st  August 2012 20.7 20.5 38 
22nd  August 2012 20.3 20.1 36 
23rd  August 2012 20.3 20.1 39 

 
6.6 Simulated Tissue Composition Used for SAR Test 
The tissue simulating liquids are created prior to the SAR evaluation and often require slight modification each 
day to obtain the correct dielectric parameters. 
 
Table: Tissue Type: Body @ 850/900MHz Table: Tissue Type: Body @ 1800/1950MHz MHz 

  Volume of Liquid: 30 Litres      Volume of Liquid: 30 Litres 
 

Table 32 

Approximate 
Composition 

% By Weight  Approximate 
Composition 

% By Weight 

Distilled Water 56  Distilled Water 40.4 
Salt  0.76  Salt  0.5 
Sugar 41.76  Sugar 58 
HEC 1.21  HEC 1 
Bactericide 0.27  Bactericide 0.1 

*Refer “OET Bulletin 65 97/01 P38” 
 
 
6.7 Device Holder for Laptops and P 10.1 Phantom 
A low loss clamp was used to position the DUT underneath the phantom surface. 
 
Refer to Appendix A for photographs of device positioning 
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7.0 SAR MEASUREMENT PROCEDURE USING DASY5 
 
The SAR evaluation was performed with the SPEAG DASY5 system.  A summary of the procedure follows:
  

a) A measurement of the SAR value at a fixed location is used as a reference value for assessing the 
power drop of the DUT.  The SAR at this point is measured at the start of the test, and then again at the 
end of the test. 
 

b) The SAR distribution at the exposed flat section of the flat phantom is measured at a distance of 4 mm 
from the inner surface of the shell.  The area covers the entire dimension of the DUT and the horizontal 
grid spacing is 15 mm x 15 mm. The actual Area Scan has dimensions of 150 mm x 90 mm 
surrounding the test device. Based on this data, the area of the maximum absorption is determined by 
Spline interpolation.  

 
c) Around this point, a volume of 30 mm x 30 mm x 30 mm is assessed by measuring 7 x 7 x 7 points.  On 

the basis of this data set, the spatial peak SAR value is evaluated with the following procedure: 
 

(i) The data at the surface are extrapolated, since the centre of the dipoles is 2.7 mm away from the 
tip of the probe and the distance between the surface and the lowest measuring point is 4 mm.  
The extrapolation is based on a least square algorithm.  A polynomial of the fourth order is 
calculated through the points in z-axes.  This polynomial is then used to evaluate the points 
between the surface and the probe tip. 

 
(ii) The maximum interpolated value is searched with a straightforward algorithm.  Around this 

maximum the SAR values averaged over the spatial volumes (1 g and 10 g) are computed using 
the 3D-Spline interpolation algorithm.  The 3D-Spline is composed of three one-dimensional 
splines with the “Not a knot”- condition (in x, y and z-direction).  The volume is integrated with the 
trapezoidal – algorithm.  One thousand points (10 x 10 x 10) are interpolated to calculate the 
averages. 

 
(iii) All neighbouring volumes are evaluated until no neighbouring volume with a higher average value 

is found. 
 

(iv)  The SAR value at the same location as in Step (a) is again measured to evaluate the actual          
power drift. 
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8.0 MEASUREMENT UNCERTAINTY  
 

The uncertainty analysis is based on the template listed in the IEEE Std 1528-2003 for both Handset SAR tests 
and Validation uncertainty. The measurement uncertainty of a specific device is evaluated independently and 
the total uncertainty for both evaluations (95% confidence level) must be less than 30%. 
 

Table 33:  Uncertainty Budget for DASY5 Version 52 – DUT SAR 

Error Description Uncert. 
Value 

Prob. 
Dist. Div. Ci 

(1g) 
Ci 

(10g) 1g ui 10g 
ui  vi 

Measurement System                 
Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 
Axial Isotropy 4.7 R 1.73 0.7 0.7 1.90 1.90 ∞ 
Hemispherical Isotropy 9.6 R 1.73 0.7 0.7 3.88 3.88 ∞ 
Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 
Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 
System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 
Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 
Response Time 0.8 R 1.73 1 1 0.46 0.46 ∞ 
Integration Time 2.6 R 1.73 1 1 1.50 1.50 ∞ 
RF Ambient Noise 3 R 1.73 1 1 1.73 1.73 ∞ 
RF Ambient Reflections 3 R 1.73 1 1 1.73 1.73 ∞ 
Probe Positioner  0.4 R 1.73 1 1 0.23 0.23 ∞ 
Probe Positioning 2.9 R 1.73 1 1 1.67 1.67 ∞ 
Max. SAR Eval. 1 R 1.73 1 1 0.58 0.58 ∞ 
Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 
Test Sample Related                 
Power Scaling 0 R 1.73 1 1 0.00 0.00 ∞ 
Test Sample Positioning 2.9 N 1.00 1 1 2.90 2.90 145 
Device Holder Uncertainty 3.6 N 1.00 1 1 3.60 3.60 5 
Output Power Variation – SAR Drift 
Measurement 4.71 R 1.73 1 1 2.72 2.72 ∞ 

Phantom and Setup                 
Phantom Uncertainty 7.5 R 1.73 1 1 4.33 4.33 ∞ 
Liquid Conductivity – Deviation from target 
values 5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from target 
values 5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – Measurement 
uncertainty 2.5 N 1.00 0.64 0.71 1.60 1.78 ∞ 

Liquid Permittivity – Measurement 
uncertainty 2.5 N 1.00 0.6 0.26 1.50 0.65 ∞ 

Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 ∞ 
Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 ∞ 
Combined standard Uncertainty (uc)           11.6 11.4   
Expanded Uncertainty (95% CONFIDENCE 
LEVEL)     k= 2   23.2 22.9   

 
Estimated total measurement uncertainty for the DASY5 measurement system was ±11.6%.  The extended 
uncertainty (K = 2) was assessed to be ±23.2% based on 95% confidence level.  The uncertainty is not added 
to the measurement result.   
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Table 34: Uncertainty Budget for DASY5 Version 52 – Validation 

Error Description Uncert. 
Value 

Prob. 
Dist. Div. Ci 

(1g) 
Ci 

(10g) 1g ui 10g ui  vi 

Measurement System                 
Probe Calibration 6 N 1.00 1 1 6.00 6.00 ∞ 

Axial Isotropy 4.7 R 1.73 1 1 2.71 2.71 ∞ 

Hemispherical Isotropy 9.6 R 1.73 0 0 0.00 0.00 ∞ 

Boundary Effects 1 R 1.73 1 1 0.58 0.58 ∞ 

Linearity 4.7 R 1.73 1 1 2.71 2.71 ∞ 

System Detection Limits 1 R 1.73 1 1 0.58 0.58 ∞ 

Readout Electronics 0.3 N 1.00 1 1 0.30 0.30 ∞ 

Response Time 0 R 1.73 1 1 0.00 0.00 ∞ 

Integration Time 0 R 1.73 1 1 0.00 0.00 ∞ 

RF Ambient Noise 1 R 1.73 1 1 0.58 0.58 ∞ 

RF Ambient Reflections 1 R 1.73 1 1 0.58 0.58 ∞ 

Probe Positioner  0.8 R 1.73 1 1 0.46 0.46 ∞ 

Probe Positioning 6.7 R 1.73 1 1 3.87 3.87 ∞ 

Max. SAR Eval. 2 R 1.73 1 1 1.15 1.15 ∞ 

Post Processing 2 R 1.73 1 1 1.15 1.15 ∞ 

Dipole Related                 
                  

Deviation of exp. dipole 5.5 R 1.73 1 1 3.18 3.18 ∞ 

Dipole Axis to Liquid Dist. 2 R 1.73 1 1 1.15 1.15 ∞ 

Input power & SAR drift 5.00 R 1.73 1 1 2.89 2.89 ∞ 

Phantom and Setup                 
Phantom Uncertainty 4 R 1.73 1 1 2.31 2.31 ∞ 
Liquid Conductivity – Deviation 
from target values 5 R 1.73 0.64 0.43 1.85 1.24 ∞ 

Liquid Permittivity – Deviation from 
target values 5 R 1.73 0.6 0.49 1.73 1.41 ∞ 

Liquid Conductivity – 
Measurement uncertainty 2.5 N 1.00 0.78 0.71 1.95 1.78 ∞ 

Liquid Permittivity – Measurement 
uncertainty 2.5 N 1.00 0.26 0.26 0.65 0.65 ∞ 

Temp.unc. - Conductivity 1.7 R 1.73 0.78 0.71 0.77 0.70 ∞ 

Temp. unc. - Permittivity 0.3 R 1.73 0.23 0.26 0.04 0.05 ∞ 
Combined standard Uncertainty 
(uc)           10.3 10.1   

Expanded Uncertainty (95% 
CONFIDENCE LEVEL)     k= 2   20.6 20.3   

 
Estimated total measurement uncertainty for the DASY5 measurement system was ±10.3%.  The extended 
uncertainty (K = 2) was assessed to be ±20.6% based on 95% confidence level.  The uncertainty is not added 
to the Validation measurement result.   
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9.0 EQUIPMENT LIST AND CALIBRATION DETAILS 
 

Table 35: SPEAG DASY5 Version 52 

Equipment Type Manufacturer Model 
Number Serial Number Calibration 

Due 
Used For 
this Test? 

Robot - Six Axes Staubli RX90BL N/A Not applicable  

Robot Remote Control SPEAG CS7MB RX90B Not applicable  

SAM Phantom SPEAG N/A 1260 Not applicable  

SAM Phantom SPEAG N/A 1060 Not applicable  

Flat Phantom  AndreT 10.1 P 10.1 Not Applicable  

Flat Phantom  AndreT  9.1 P 9.1 Not Applicable  

Flat Phantom  SPEAG ELI 4.0 1101 Not Applicable  

Data Acquisition Electronics SPEAG DAE3 V1 359 21-June-2013  

Data Acquisition Electronics SPEAG DAE3 V1 442 05-Dec-2012  

Probe E-Field - Dummy SPEAG DP1 N/A Not applicable  

Probe E-Field SPEAG ET3DV6 1380 12-Dec-2012  

Probe E-Field SPEAG ET3DV6 1377 20-June-2013  

Probe E-Field SPEAG ES3DV6 3029 Not Used  

Probe E-Field SPEAG EX3DV4 3563 21-June-2013  

Probe E-Field SPEAG EX3DV4 3657 14-Dec-2012  

Antenna Dipole 300 MHz SPEAG D300V3 1012 30-Nov-2012  

Antenna Dipole 450 MHz SPEAG D450V3 1074 30-Nov-2012  

Antenna Dipole 750 MHz SPEAG D750V2 1051 9-Jan-2014  

Antenna Dipole 900 MHz SPEAG D900V2 047 22-June-2014  

Antenna Dipole 1640 MHz SPEAG D1640V2 314 20-June-2014  

Antenna Dipole 1800 MHz SPEAG D1800V2 242 20-June-2014  

Antenna Dipole 1950 MHz SPEAG D1950V3 1113 10-Dec -2012  

Antenna Dipole 2450 MHz SPEAG D2450V2 724 09-Dec-2012  

Antenna Dipole 2600 MHz SPEAG D2600V2 1044 10-Jan-2014  

Antenna Dipole 3500 MHz SPEAG D3500V2 1002 13-July-2013  

Antenna Dipole 5600 MHz SPEAG D5GHzV2 1008 14-Dec-2013  

RF Amplifier  EIN 603L N/A *In test   

RF Amplifier  Mini-Circuits ZHL-42 N/A *In test   

RF Amplifier  Mini-Circuits ZVE-8G N/A *In test   

Synthesized signal generator Hewlett Packard ESG-D3000A GB37420238 *In test  

RF Power Meter Hewlett Packard 437B 3125012786 30-Aug-2013  

RF Power Sensor 0.01 - 18 GHz Hewlett Packard 8481H 1545A01634 03-Sept-2013  

RF Power Meter Rohde & Schwarz NRP 101415 21-Sept-2012  

RF Power Sensor Rohde & Schwarz NRP - Z81 100174     21-Sept-2012  

RF Power Meter Dual Hewlett Packard 435A 1733A05847 *In test  

RF Power Sensor Hewlett Packard 8482A 2349A10114 *In test  

Network Analyser Hewlett Packard 8714B GB3510035 27-Sept-2012  

Network Analyser Hewlett Packard 8753ES JP39240130 7-Nov-2012  

Dual Directional Coupler Hewlett Packard 778D 1144 04700 *In test  

Dual Directional Coupler  NARDA 3022 75453 *In test  

Radio Communication Test Set Rohde & Schwarz CMU200 101573 Not Applicable  

Radio Communication Test Set Anritsu MT8820A 6200240559 Not Applicable  

Radio Communication Test Set Agilent PXT E6621A MY51100168 Not Applicable  

* Calibrated during the test for the relevant parameters. 
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10.0 TEST METHODOLOGY 
Notebooks should be evaluated in normal use positions, typical for lap-held bottom-face only. However the 
number of positions will depend on the number of configurations the laptop can be operated in. The 
“STYLISTIC T SERIES ” can be used in either a conventional laptop position (see Appendix A) or a Tablet 
configuration.  
 
 
10.1.1 “Lap Held” Position Definition (0mm spacing) 
The DUT was tested in the 2.00 mm flat section of the AndreT Flat phantom for the “Lap Held” position. The 
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of the DUT 
was touching the phantom. This device orientation simulates the PC’s normal use – being held on the lap of the 
user. A spacing of 0mm ensures that the SAR results are conservative and represent a worst-case position. 
 
 
10.1.2 “Edge On” Position 
The DUT was tested in the (2.00 mm) flat section of the AndreT Flat phantom for the “Edge On” position. The 
Antenna edge of the Transceiver was placed underneath the flat section of the phantom and suspended until 
the edge touched the phantom. Refer to Appendix A for photos of measurement positions. 
 
10.1.3 “Bystander” Position (25mm spacing) 
The DUT was tested in the 2.00 mm flat section of the AndreT Flat phantom for the “Bystander” position. The 
Transceiver was placed at the bottom of the phantom and suspended in such way that the back of it’s LCD 
screen was parallel to phantom and at 25mm distance.  This orientation simulates use of the device in a way 
that allows occasional RF exposure of the nearby person (Bystander).  
 
  



 WWAN - FCC ID: N7NMC8355 IC: 2417C-MC8355     Report No. M120829_FCC_MC8355_SAR_GSM-UMTS            Page 28 of 190 
  

 

Accredited for compliance with ISO/IEC 17025. The results of the test, calibrations and/or measurement 
included in this document are traceable to Australian/national standards.  NATA is a signatory to the ILAC 
Mutual Recognition Arrangement for the mutual recognition of the equivalence of testing, calibration and 
inspection reports. 

This document shall not be reproduced except in full. 
 
 

10.2  List of All Test Cases (Antenna In/Out, Test Frequencies, User Modes) 
The DUT has a fixed antenna. Depending on the measured SAR level up to three test channels with the test 
sample operating at maximum power were recorded. The following table represents the matrix used to 
determine what testing was required. All relevant provisions of KDB 447498 and KDB 941225 are applied for 
SAR measurements of the host system. SAR measurement for the HSDPA and HSUPA modes were not 
conducted because SAR results in WWAN bands are lower than 1.2 mW/g (75% of the SAR limit)  
 
Table: Testing configurations 

Table 36 

Phantom 
Configuration  

Device Mode 
WWAN Band 
Name  

Test Configurations
Channel 
(Low) 

Channel 
(Middle) 

Channel 
(High) 

Lap Held 
  

GPRS 850 MHz   x  
GPRS 1900 MHz x   
WCDMA 850 MHz  x  
WCDMA 1750 MHz   x 
WCDMA 1900 MHz   x 
CDMA 850 MHz  x  
CDMA 1900 MHz x   

Edge On GPRS 850 MHz   x  
GPRS 1900 MHz x   
WCDMA 850 MHz  x  
WCDMA 1750 MHz   x 
WCDMA 1900 MHz   x 
CDMA 850 MHz  x  
CDMA 1900 MHz x   

Bystander GPRS 850 MHz   x  
GPRS 1900 MHz x   
WCDMA 850 MHz  x  
WCDMA 1750 MHz   x 
WCDMA 1900 MHz   x 
CDMA 850 MHz  x  
CDMA 1900 MHz x   

 
Legend 

X Testing Required in this configuration 
  
 Testing required in this configuration only if SAR of middle channel is more than 3dB 

below the SAR limit or it is the worst case. 
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11.0 SAR MEASUREMENT RESULTS 
 
The SAR values averaged over 1g tissue masses were determined for the sample DUT for all test 
configurations listed in section 10.2.  
 
11.1  SAR Results 

 
There are three modes of operation which include UMTS, GPRS and Ev-Do transmission. Table below displays 
the SAR results. 
 

Table: SAR MEASUREMENT RESULTS – 850MHz GPRS 

Table 37 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 
The highest SAR level recorded was 0.719 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Lap Held Antenna Out “ position in GPRS mode, utilizing channel 190  (836 MHz).  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 190 836 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 1 190 836 0.483 -0.11 

      
Lap Held Antenna In - 190 836 Noise Floor N/A 
Lap Held Antenna Out 2 190 836 0.719 0.02 
      
Secondary Portrait Antenna In 3 190 836 0.011 -0.02 
Secondary Portrait Antenna Out 4 190 836 0.296 -0.15 
      

Secondary Landscape Antenna In 
5 128 824.2 0.355 -0.03 
6 190 836.6 0.431 -0.08 
7 251 848.6 0.358 0.03 
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Table: SAR MEASUREMENT RESULTS – 1900MHz GPRS 

Table 38 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 

The highest SAR level recorded was 0.341 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Secondary Landscape Antenna In “ position in GPRS  mode, utilizing channel 661 (1880 MHz).  
 

 
Table: SAR MEASUREMENT RESULTS – 850MHz UMTS 

 

Table 39 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 

The highest SAR level recorded was 0.488 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Lap Held Antenna Out “position in UMTS mode, utilizing channel 4132 (826.4 MHz).  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 512 1850.2 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 8 512 1850.2 0.149 0.13 

      
Lap Held Antenna In - 512 1850.2 Noise Floor N/A 
Lap Held Antenna Out 9 512 1850.2 0.267 0.09 
      
Secondary Portrait Antenna In - 512 1850.2 Noise Floor N/A 
Secondary Portrait Antenna Out 10 512 1850.2 0.295 0.08 
      

Secondary Landscape Antenna In 
11 512 1850.2 0.154 -0.17 
12 661 1880 0.341 0.07 
13 810 1909.8 0.281 0.20 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 4183 836.6 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 14 4183 836.6 0.358 0.02 

      
Lap Held Antenna In - 4183 836.6 Noise Floor N/A 
Lap Held Antenna Out 15 4132 826.4 0.488 -0.08 
      
Secondary Portrait Antenna In - 4183 836.6 Noise Floor N/A 
Secondary Portrait Antenna Out 16 4183 836.6 0.235 0.07 
      

Secondary Landscape Antenna In 
17 4132 826.4 0.216 -0.17 
18 4183 836.6 0.208 -0.05 
19 4233 846.6 0.283 -0.07 
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Table: SAR MEASUREMENT RESULTS – 1750MHz UMTS 

Table 40 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 
 
The highest SAR level recorded was 0.328 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Secondary Portrait Antenna Out” position in UMTS mode, utilizing channel 1513 (1752.6 MHz).  

 
 

Table: SAR MEASUREMENT RESULTS – 1900MHz UMTS 

Table 41 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 
 
The highest SAR level recorded was 0.546 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Secondary Landscape Antenna In” position in UMTS mode, utilizing channel 9538 (1907.6 MHz).  

 
  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 1513 1752.6 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 20 1513 1752.6 0.156 -0.02 

      
Lap Held Antenna In - 1513 1752.6 Noise Floor N/A 
Lap Held Antenna Out 21 1513 1752.6 0.321 0.03 
      
Secondary Portrait Antenna In - 1513 1752.6 Noise Floor N/A 
Secondary Portrait Antenna Out 22 1513 1752.6 0.328 -0.09 
      

Secondary Landscape Antenna In 
23 1312 1712.4 0.107 0.19 
24 1427 1735.4 0.120 -0.02 
25 1513 1752.6 0.149 0.10 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In 26 9538 1907.6 0.007 -0.14 

Bystander  
25mm Spacing  Antenna Out 27 9538 1907.6 0.197 -0.11 

      
Lap Held Antenna In 28 9538 1907.6 0.011 -0.14 
Lap Held Antenna Out 29 9538 1907.6 0.368 -0.12 
      
Secondary Portrait Antenna In 30 9538 1907.6 0.014 0.06 
Secondary Portrait Antenna Out 31 9538 1907.6 0.291 0.00 
      

Secondary Landscape Antenna In 
32 9262 1852.4 0.256 0.11 
33 9400 1880 0.371 -0.05 
34 9538 1907.6 0.546 0.13 
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Table: SAR MEASUREMENT RESULTS – 850 Ev-Do 

Table 42 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 
 
The highest SAR level recorded was 0.521 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Lap Held Antenna Out” position in Ev-Do mode, utilizing channel 0384 (836.52 MHz).  

 
 
 

Table: SAR MEASUREMENT RESULTS – 1900 Ev-Do 

Table 43 

NOTE: The measurement uncertainty of 23.2% was not added to the result. 
 
 
The highest SAR level recorded was 0.449 mW/g as evaluated in a 1g cube of averaging mass. This value was 
obtained in “Secondary Landscape Antenna In” position in Ev-Do mode, utilizing channel 1175 (1908.75 MHz).  

  

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 0384 836.52 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 35 0384 836.52 0.483 0.08 

      
Lap Held Antenna In - 0384 836.52 Noise Floor N/A 
Lap Held Antenna Out 36 0384 836.52 0.521 -0.10 
      
Secondary Portrait Antenna In - 0384 836.52 Noise Floor N/A 
Secondary Portrait Antenna Out 37 0384 836.52 0.251 0.10 
      

Secondary Landscape Antenna In 
38 1013 824.7 0.212 -0.15 
39 0384 836.52 0.217 -0.12 
40 0777 848.31 0.261 -0.01 

Test  
Position 

Plot 
No. 

Test 
Channel 
 

Test Freq 
(MHz) 

Measured 1g 
SAR Results 
(mW/g) 

Measured 
Drift (dB) 

Bystander  
25mm Spacing Antenna In - 0025 1851.25 Noise Floor N/A 

Bystander  
25mm Spacing  Antenna Out 41 0025 1851.25 0.265 0.05 

      
Lap Held Antenna In - 0025 1851.25 Noise Floor N/A 
Lap Held Antenna Out 42 0025 1851.25 0.417 0.06 
      
Secondary Portrait Antenna In - 0025 1851.25 Noise Floor N/A 
Secondary Portrait Antenna Out 43 0025 1851.25 0.414 -0.17 
      

Secondary Landscape Antenna In 
44 1175 1908.75 0.449 -0.02 
45 0025 1851.25 0.302 -0.02 
46 0600 1880 0.338 -0.10 
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12.0 COMPLIANCE STATEMENT 
 
The Fujitsu TABLET PC, Model: T732 / TH702 with SIERRA WIRELESS Mini-PCI Wireless WAN Module 
(GOBI 3000), Model: MC8355 was found to comply with the FCC and RSS-102 SAR requirements.  
 
The highest SAR level recorded was 0.719 mW/g for a 1g cube. This value was measured at 836 MHz   
(channel 190) in the “Lap Held Antenna Out “ position in GPRS transmission mode. This was below the limit of 
1.6 mW/g for uncontrolled exposure, even taking into account the measurement uncertainty of 23.2 %. 
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13.0 MULTIBAND EVALUATION CONSIDERATIONS 
 
Fujitsu Tablet PC, Model: T732 / TH702 can be equipped with GOBI3000 WWAN transmitter in addition to 
WLAN and Bluetooth.  
 
 
Report numbers M120826_62205ANHMW_SAR_2.4 and M1200826_62205ANHMW_SAR_5.6 relate to SAR 
testing of a T732 / TH702 sample that includes the INTEL 62205ANHMW  WLAN module. 
 
According to the FCC SAR evaluation procedures mentioned in KDB447498, when the sum of SAR results 
(simultaneously transmitting antennas WLAN and WWAN) is > 1.6mW/g, or the ratio of above sum to the 
distance between peak SAR locations > 0.3, simultaneous transmission SAR evaluation is required. 
 
In addition, according to the FCC SAR evaluation procedures mentioned in KDB 616217 stand-alone SAR 
evaluation is NOT required when the maximum transmitter and antenna output power is less than or equal to 
60/f(GHz) (Pref) The Bluetooth module in the DUT operates in the 2.4GHz range. It has a maximum output power 
less than 5mW which is < Pref (=60/2.4=25mW).  
 
The shortest distance between the BT module and any other transmitting antenna was more than 23.1cm.  
Because 23.1cm > 5cm, and 5mW < 25mW, the Bluetooth module was not considered for SAR evaluation. This 
is in accordance with the test reduction methods detailed in KDB 616217 and KDB 447498. 
 
 
Multiband evaluation was not conducted for UMTS/GSM/CDMA WWAN (GOBI3000) and WLAN 
(62205ANHMW) because the ratio of the sum of highest SAR results for the WWAN and WLAN (5GHz band 
Antenna A)  to the distance between peak SAR locations of  WWAN transmitting antenna and WIFI Antenna A 
is  (0.55 + 1.27) mW/g / 6.28 cm  = 0.29 < 0.3. 
 
Diagram Showing distance between Peak SAR Locations WWAN (GOBI3000) and WIFI (62205ANHMW): 
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Diagram Showing distance between Antennas 
 

  


